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This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of

making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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Main menu Sub menu

— Input — VGA
— DVI (available for selective models)

— HDMI, HDMI2 (available for selective models)
— MHL-HDMI (available for selective models)

— Picture — Picture Format —— Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
— SmartResponse —— Off, Fast, Faster, Fastest

(available for selective models)

— SmartContrast — On, Off
[ Pixel Orbiting — On, Off
(available for selective models)
L— Over Scan — On, Off
(available for selective models)
— Volume — 0~100
— Audio (available for selective models)
— Stand-Alone — On, Off
— Mute — On, Off
I Color — Color Temperature =~ — 500K, 9300K
— sRGB
—— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English, Espaol, Francais, Deutsch, Italiano,
Portugués, Pycckui, KA 3L, Tirkce
—— OSD Settings [— Horizontal — 0~100
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time Out — 5s, 10s, 20s, 30s, 60s
— Setup — Auto
— H.Position — 0~100
— V.Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L— Information
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Brightness

B Brightness vl result 03 o of

the Brightness for

Beightress 100
= o

Undo Raset

Bix
PHILIPS

Contrast

Adjust the Contrast {ise the skder) to keep dataik n
kghter image areas,
1. Hake the Contrast untd the numbers 1 and 2
are no longer visble.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number |
should remam barely vishle,

Contrast 50

= o

+

Unda

12
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Color
Focus
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options 5

Resolution
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Focus

Your display’s timng needs to be smchronzed with
the wdeo sgnal.

1. thoose Auto Setup.

2. I the vertical bands are stil visble, vou'l need
adjust the Pitch.

Pitch: Try to meke the vertical bands deappear.
Phase: Adjust to the brightest setting to minimze
mavement on the screen.

Pitch 30

S ¢ &

Phasa 17

g—=0 &
Undo Auto Setup

[Ex
PHILIPS

Position

Uy thee Position but:

Undo Rt

B
PHILIPS

Resolution

You are curently 3t 2 Preferred resolibon. For your
deply to show arso, dear test, cobors, and mages,
vour display should be set to s Preferred resohiton.

I your display Is 2t 2 Mon-Preferred resolution, dick
on the Preferred button to change your resolition to
Preferred.

™ Enabie Resolution Motfier

Picture Forrmat
I 4:3 asect ratio

Prefemed

M




Color menu (Wﬁﬂ):

N n_n 2 NN
A (TG 'El?id‘ll“lf’hl SHRSIG], sxfen ¢lded, lsc

WEe, THER hellovH, 3T Smartimage Lite
(P9 Smartimage Lite STTHFT <& ) i
TSI A T STTAM <A 2|

o 3T T Rl UTeH R §U FHES R Hhd § |

o U Y W ARG IU-H=Y MeeHl o oy

frfafaa arfererr <d |

o ol helloleM i SSEI:

B St Contol

SmartControl Lite

Adjust RGE
\‘ jﬂu
: e
Color wihite Pont
—
Deplay Gamma
-
Options Gibiston
s ap
Srrarthrage
Hilp
W St Control

SmartControl Lite

Adiust RGE
\’ Back Lavel
Culor ml Pont
e
Dby Garmerua
LA
Opbons Calbration
.@J-\
\g Srartirage
Hulp

i)
PHILIPS

Black Level

Rt a0
= o 4
Grose 20
= D +
Bl w0
= &

Unida Rasat

Bix
PHILIPS

White Point

White Point & the
of rad, green, a
mst BCCurate oo
salect the Whitz Point

L. Please sedact the Whita Pont valse for the best
posshle color gualty

:]
£
I+ g
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W St Contiol

SmartControl Lite

RGB

I Adjust
A Dack Laved
- o

White Pont

Depliy Garmeri
LA
Opbons Calbration
_ ab
\g Srartimage
Hulp
W St Contol

SmartControl Lite

W

Adjust RG8
Cokor wihie Pont

Desplay Gamma

= .

Help

2%
PHILIPS

Display Gamma

Gamma & 3 component of the pwel brghtness n a
deplay. A lower Gamma vakie produces brighter piels
and a higher Gamma value praduces darker preak, The
defaule value for Gamma 5 2.2.

To adiust Gamma, Smartimege must be set to OF.
Cick the Smartmage Off button before adustng
Gamma.

1. Use the sider to select the desred Camma.

Dsplay Gamma 22
& 4

[Ex
PHILIPS

Calibration

quaity frst.

2. Press Show Me to lzam how to use the
calibration took.

3. Finaly, press Start to begin the calibration
process.

W Enabiz color calbeation
s an: dosigned i

aboeation with Joseph

Protected by LLS. Patent No. 6,686 953
Show Me Start
Quick View

“Show Me (3If HY) "' Shel Sheftore Treror =t

BT T & |

e - 6 T o] el hAtSgH shH i

BT T & |

foaen = TRa/aR *i SfeEl 1 de Ha
HeR B U9 W 999 1 & g, ' & 921

IR faeTe i)

ST hel hicAslsH - fewiee IR W 3 &l

¥ 1 afg o 7 @ 8, @ R SHiceee wi

arAfa Tt faerdt €, SR o18e Sy iR

e 1 faaeheg T ¥ |

KT ThiA W U AT BT =T |



o TUSen 929 T HeR BhiA & YSRid 8 dh
e Tl € |

o THF SIS AN oA AT (6-18F) T 1 € |

o 3dd: File>Presets U7 T TTTI'Q.TI

« T R FIME HI a9 B AT ¢ IR -3 T3

TR SO <Al Sl |

Smartimage Lite

Il o YR T a8 v i & faw g =l
YT g i A T T |

TR & TNfid €1 M % 9IS, SmartContrast 3R

SmartResponse H&H SIS

W St Contiol

SmartControl Lite

RGB

J.
o

White Pont

Sk |
Display Gamma
=

Gilbraton

ap

Errartirage

2
PHILIPS

Smartimage

S
o

Standard

Internet

fasremurarfaehard -4l 9fsha g Ste qrerfiehansti .
1 EMI-Tre foed 7= § T1 S @1 20 | St/
Hems warw fordt sramffd feot W, Shae eI

3R faered 3o AisE B4 € |
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W St Contiol

2%

SmartControl Lite PHILIPS

Preferences

NOT

A Frefendr Sfere yefiia i ¢ |

9T @ S RieR T W il § | e
T S 2T B |

SEReT T shedhe Ty T&m i fewice dr
TR TFE () B ¢ | heRe T TaH hi
ST o Tge-Toeh sheae = # ANl
A 3R A fedq=l & SmartControl Lite =1
o YR T © | 318TH SmartControl Lite @l
Tzt e A Y g S B |

T ¢ AEeH FaH i fewhiee dR |

TS () T T | heoRe B Wam i
SmartControl Lite @ foq o= ? W‘Eﬁh
FHAT € | TEH $ 3EHH R T3 foedsh e |
Help (¥F&TAdT), Technical Support (dehHiTeht
FHAT ), Check for Update (3TTSE 9 i),
About (IR H), 3R Exit (sMeX 31md) & fag
= foereq wefid 214 € | <@ 2k 2 7=y ward
T A& Bl 8, A Tk ¢ EH el fehet
fe@mTm |

WY R Fam fewiee dR | = (37H)
BIA1 8 | 31879 ¥ W, SmartControl Lite Y% &M
R A &I B | SmartControl Lite @l &=
S T TR TRl I1 I SEheld o IMeehe
W I W™ WEA & g § | 39 S & Faas
(315M) TM W WESTT R T & foe vgat 9
foman T B oft W <ire et B

Tew yrefiar At (faeis 7, faes 8) |
femiee 0% STareet ST ¥ |




Options>Input ( fahemgTqE ) - a4l disha
BT STal gIU-213 foehed 7= | 379 A1 T

B | SIStEl/dters wem fedt iy feaw m,
FHael T iR foshey 39 HisE 21 ¥ | 311 Tt
SmartControl Lite oo SYeT &1 &M |

B St Contol =

SmartControl Lite PHILIPS

Input

Adjust Audn
AUTD PNOL
Conor Input
- + h
Wirard
2
options Presets
V‘g M Monkars
Hulp

Analog In Dyl in

o T fefa s 99 SR HiNE $1Ye E
i yefdia &l

o Hia FER e 11 SR ANl e §d
i yefdia &l

Options>Audio (Taseasaaifedr) - awft wfora grm

& Audio (#ifeaT) &l U-8RA Option (fashed)

T 9 AT ST @B

Srerd/dres Tam foedt stmfyfa fegwt ©, haa
TeTaT iR fashey 39 Hisg 2 ¢ |

B St Contol T

PHILIPS

Ix

SmartControl Lite

Audio

sggaAR

Vohame
Help s -

Undo

Help>User Manual ( FMEAHIST B3 ) -
a«t wfsha g STd gu-S=+ Herdl #g H i
B37et Rl AT S &1 2 | EIStE/dteTs qar foredt
STEAFT feral W, el T SR fasheq &

ARG e |

W SmartControl X

SmartControl Lite PHILIPS

User Manual

*

‘Color g

. Diszlay ID
\_@

Optons: r;.’

Hep

Help>Version ( @gTaabasi= ) - @it afeha g
& EIU-SR3A Tl 4= § aSiA i AT S @1
TR | STSTHl/HieTE wam fordlt sTmfd feum m,
Fae TETl 3R fasheq 3 Higg 1 € |

B smartControl @

PHILIPS

Usar Manual Tach. Suppart

SmartControl Lite

Version

=

Adpst
LB
Ur Manua
= =
Undwe
Codor
s
s Deoiay ID
System 10
Optons

3(5
i
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heare dfafea 7=

sheae dfafea A= fewice IR W Hem &1 7 1 AfE
fasheasmafiehad 99 § sheRe U 9&d i Jh
[ERIKIRIRI A PR R C R

g SmartControl

Select Presat 4

Tune Display

Smartlmage

HewRe U | =R wfafyat e &
*  SmartControl Lite — ST& FAT T Bral TAF
TR H B Yafid g g |

+  Select Preset (WI¥E ) - ATehIfcish IR
& foTu TRt 7T Wy 1 Jofiiag 7= oM
AT § | Tk el T 9919 g 73 a1 e
femmar & | Thahrel W8 g-era 5 § o
ST ST Hehall € |

. %’H’@l"ﬁﬁaﬁ SmartControl Lite 7= 3@
T Tl ¢ |

*  Smartlmage Lite - A Wi, Standard
(FeD), Internet (322), Game (1) i
ST o |

Task Tray Menu Enabled ( 2%k < 5= Ta fowar

T )

IEh $ ﬁqaﬁ %R ¢ ° SmartControl Lite 3TTgehiT

R foeTeh ¥k Tefia foran S Hehan © | oo foerh

ST I e S M |

Help

Technical Support
Check For Update
About

Exik

Tk ¢ T U wiafa g 8

*  Help (F8TAT) - IR HI3TA TIEA dh U H:
fewiee JRSR foel =1 W iXd T R
T wIEd I @it |

16

e Technical Support (Teh-ieht THLA) — Tehteh!
A I3 YRFId a1 T |

*  Check for Update (3T9SS I W= Hi) -
SYANTR! i WSS e W & o § 3R
STl o i i AAqH SUCTSY TRl
Y T T € |

«  About (% IR H) - fawga ded =1 yeffa
AT T: IS T I, S 6t T8 oI, IR
IS T A |

o Exit (SRR Fhel) - SmartControl Lite &g &Y |
SmartControl &l I & faTT Lite o1 ftR & =@M
o T = a1 9 5= ¥ SmartControl Lite T,
SR PC ATZHA W Soei-Toeteh i 41 faeed
=R |

PHILIPS

SmartControl

SmartControl
‘ersion 3.20
chune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Displaye, Inc.
Patents Pending

Task Tray Menu Disabled ( 2%k < =] 31810
foram )

ST WATHehdl Wieed § 2%k ¢ 378 Bl 8, d
hael deR fehet =@ STy &Il € | SmartControl
FEs Pl TR ¢ W T TWE g & fag,
Options>Preferences (faareds>uTeIfHeRard ) # W™
T T 3T&TH Y |

6

=0 e H Tt Wi e Hed & fag ¥
SmartControl FTFEeaR FERU T SAferg=r

o IS ST Hhal § | SmartControl TTHEe?R
T HERTUT ] SRAAE L o T FHo=m FHem
STfYRIRe dide dedge www.portrait.com/dtune/

phl/enu/indexé’@ﬁ Rl




4. WIZHIBIA & Y afHied ad
crsnll

e
e KA GTferd hid & fau Hifqet o) 9t &
o Jugs e ST | |

I HHY AT TS W e aed difedr AR Affear
hIRT I I T STTART T € | 9gd IR T
3R & i o9d & 1Y I8 FRIEN SAfwa=l
AT SR 7= ANl o W19 Halg i o foag
G gfaureieh TR STEM ekl YSH il § | STTTh
T A9 HAY Fem Ty fom € a&dik o, et
I AT I ARSI ST L HT SHHTA TR
T TR W R & § | Aeshre iR fafafy
yehTel Feemt o SIoiel T od Y Sl WEH H § |

V%‘. ®

4.1 gt faea &t Tayasdhard

AR fey: AEmEiR oSN 7,
TEhEe faes faw, aemae faes
TEd (TEE2), IR HIE T AUy S Juast

2.0 |k & Ted JarHl/guE( Juasi sifeat
FAY IEY / AT o STET) 1 FHAA
LT B |

T 1.6 GHZz 31 399 21feh

RAM 512 THST (Tadt & fam) / 1 Sfsi
(forzr ok foeie 7 & fam)

T1e ferh T9 : gFaq 200 THe

Juyst: JUAS 2.0 A 394G Afueh A JuE
AL
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4.2 Tearsa ot SUANT AT

TR IR o WY fRfae Hife JuEst 9 & A
Y dfifear IR A T2 TWHIARE il © | 78 hae 191
FUHET hoel ! UTE § UGS 8 ok STOH H W A AR
W AR & AT i Wb SATSH i a1 ST Tohell T |

1. Y JUEs] hael I JUHS & ok AT H
it ot SR G Hifel & TESl o WE e,

2. SO T =] Y SR ghafem Y foh stmaem
I HARME ek H B @€ |

3. 1Y, i HUSR o ®9 § g Siae =e
TIFER, a1 THhe Si3Tals 3T gfshd i,
39 Heel kg onfe S s uftsa
IYINT o A H, FHfid 9iRedsm & fag
Hewdl o 9hd &

4. I HH T F AU ST FE A LSS e
& WEqH Y B hicl Hi & fag TR R

5. Geddl WM & 991 1 U e hiel
R
6
Fifeat s o o oI, eT9eh! =feq Ueh faga g
SR =1 Sfifedt wF wia gm | gihafvea # f6
31 forg =afad =1 i W ©@ € T 9% 9 g
Sifedt w Giwear ® | difes &R aiifear gesi
&I TUTET SH1 A R ITesy Sefagy W R
FHr & | TS =afaq =7 319 el W@ E STh e
SUHLON 3T TIHRAZR i TH & i &THdT B!
el




5. deh-leht faavuT

ferr / fe==I( 247E4QSD, 247E4QHAD,247E4QHKAD, 247E4QHSD )

feru 3uersy ¥)

Hif e Tl % THR AT TerHet
CETTIES LED

YIeT T SRR 23.6 " T (59.9 W)
TEYR ST 169

o fo= 0.2715 x 0.2715 Toe
EIECRES! 250 cd/m?
SmartContrast 20,000,000:1

heeE T (iaToTeh ) 1000:1

T 1 99T () 14 Hied
SmartResponse (T Higd % - e

qaiaH TR

1920 x 1080 60 Hz WX

TG HT HI 178° (H) /178° (V) @ C/R > 10
o =iwHe Smartimage Lite

feuw=t & TR 167 M

et R @ 56Hz - 76Hz

&fast e 30kHz - 83kHz

THTHTA 1080P@30Hz

sRGB Bl

T

247E4QSD: dSiY, (TATEAT ), SreteTg (fefTea, waei)
247E4QHAD,247E4QHKAD, 247E4QHSD: it (TATArT)

SR weETHeT (fefied, TEH), THTaTe TaewweT (fefved,
RESEIRID)

. . 247E4QHAD,247E4QHKAD : Tt siifea-gm, 332
SUSATRY €I 247E48HSD : @@Sﬂaﬁ Jfer r3e e
ERACARISEH T fereteh, B W foreteh aht
ferr / Te@=t ( 247E4LSB, 247E4LHAB, 247E4LHSB )

T Tt & TR AR TS
ECIGIED LED

YTET T 3THR 23.6 " €9 (59.9 §H)
THUSRE 3TIU 16:9

foe = 0.272 x 0.272 9 fht
IECR S| 250 cd/m?
SmartContrast 20,000,000:1

Thee A (ATreToTeh) 10001




ferr / fewt (247E4LSB, 247E4LHAB, 247E4LHSB )

YT 1 gHT (AR )

5ms

SmartResponse (FAfd Aigd &
AT Sqetsy §)

2 Hied

el STgeher 1920 x 1080 60 Hz WX

S 170° (H) / 160° (V) @ C/R > 10
T giHe Smartlmage Lite

feuwi & el 16.7 M

SeAieR e @ 56Hz - 76Hz

afest smafe 30kHz - 83kHz

sRGB &l

i

247E4LSB: ESiT. (T, Stetets (fefSea) TaeiEd)

faet 31ge 247E4LHAB, 247E4LHSB; SST (TATAN), TaeiumeTEx 2 (fefved,
TISHd)
y 247E4LHSB : TIETHSTE Affedl 3iise
aAtfea - .
S VATEALHAB : Trt Sife-37, SR sitse
ERRCATE Gl o7 foeTen, B¢ W foeteh i

gf

|

TIEhIHH IR TSl Yo o 1Y 2.0 FNIeIe hel

I T S (e 247E4QHKAD Aied T Uy )
247E4QSD, 247E4LSB, 247E4QHSD, 247E4LHSB:
i &/v ©/A 0/ < /0K 0]
R 247E4QHAD,247E4QHKAD, 247E4LHAB:
/v ©/A 10/« 8/0K 0}

= gl e dieh
T T T Gl DDC/Cl, sRGB, faes 7/f6€IS 8, Mac OSX, e
Ecaly -5°/+20°
3 Ore 29.3W (w9,
Y (27E.) 0.5W
< (2M=4.) 0.3W
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R T3 1. YIh 3 HIS ®/Ee, Lo/ Are: = (fsiw)
ek TIATS &, 100-240VAC, 50-60Hz

Tl (247E4QHAD)

3 HIE 30.3W 37.9W (2184.) (Afeehan)

A9 (2E9.) 0.5W

< (21E9.) 0.3W

TfeR Tl L. ga&h 3T IS RTge, Wear/ i He: &&e (fih)
TTeR TS &L, 100-240VAC, 50-60Hz

I Hre 30.3W 37.9W (2rE9.) (ferehaH)

Y (27E9.) 0.5W

< (IMEM.) 0.3W

TR TA.E. S YIh A HIS ®Ee, LWead/&iy Are: = (fsiw)
TieR TS S, 100-240VAC, 50-60Hz

T HIE 303W (2EY.),

w9 (IE9.) 0.5W

=< (28Y.) 0.3W

TR TA.E. S Yah Y HIS ®/Ee, LWead/&iy Are: = (fsiw)
HleR TeE M, 100-240VAC, 50-60Hz

= e 204W (<¥rW.),

w9 (=) 0.5W

=< (28Y.) 0.3W

e T3, €1 o 3 HAreREe, Lead/&iy Are: = (fsiw)
RIEIES K] e, 100-240VAC, 50-60Hz

TieX (247E4LHAB)

= HIS 213W (2E4.), 29.7W (AfHhdH)

A9 (2E.) 0.5W

< (21E9.) 0.3W

R TA.5. 1. JFh = HIg =132, Lear/ &y Are: = (fsish)
TTeR TS &L, 100-240VAC, 50-60Hz

= Hre 213W (2EW.),

Y (27E9.) 0.5W

o< (2189.) 0.3W

R TA.E. 2. §ah 3T T ®IEe, Ledd/wi Hre: =ee (fsei®)

20




RICTE= I R, 100-240VAC, 50-60Hz

e Ffed I (WxHxD) 557 x 434 x 193 Tt

e & o1 IAE (WxHXD) 557 x 348 x 39 Tt

|

e gfed 3o 3.44 fopeirmm

we & fort 3 316 fom.

Yapfsi wfea e 5.60 TR,

A9 ht IS (T 0 ferit Afcaaa F 40 et Afcaag
A 1 3 ~20 fetit dfew=a F 60 feuit dfcaem
(TR-g=mer)

qrafareh STRal 20 feit Afcmzm 9 80 ferit dfcmam
MTBF 30,000hrs

i

ROHS =l

EPEAT THeaR (www.epeat.net)

TRfSiT 100% TargsRiae

fafere fewd 100% HreTet SRR Hod ST
TSt =R Ll

i
a

HE AT, THETH! A off, ST, YA 1, STl Y1 Jue /

BRIEEEEICARRI = e, TS 9241-307
I
HR 247EAL AR /247E4Q: feh =, AT 79 & § A1 3T 1 faeheq
ferfar Baslisl
6 e

. EPEAT Tiiee Sl g8l |91 § ST {th{cTod STUTg <l Tsiiohd ohidl © | 379 <91 H Usieh<u i fefq & an &
Wﬁmmwww.epeatnetawmml

Ig < for1 = & afafda fohan S Ferdl § | ek o TEiad asid ol SRAE i o fag

www.philips.com/support 9 ST |

—_

g
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5.1 ISP Td TAHE |

1 EIRESE RS N
1920 x 1080 60 Hz W (TATANT 37Y<)
1920 x 1080 60 Hz W (fefsiedt 37qe)

12 ERRGSIERS A
1920 x 1080 60 Hz R (fefsieat g192)

H. freq (kHz) ESIERRE] V. freq (Hz)

31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
63.89 1280x1024 60.02
79.98 1280x1024 75.03
55.94 1440x900 59.89
70.64 1440x900 74.98
65.29 1680x1050 59.95
67.50 1920x1080 60.00
6 e

FHUA M 3 T SA9eR1 feqmw=d 1920 x 1080 @60Hz
& Afcd WIeRH T Faad & 8 M H © |
fegwt =t warad Turer o oy, oA S
et 39 HEfd I e |



6. Sl GaielH

FfE Sk PC TVESA DPM & 3TT&Y feomt &1 =
oo Heenfud g, @ SR # 7 81 T AifeR
T 3T Soll o o7 | HHT FR el § | ATE Rt
FHErS, H3H AT 3T 374 SYHU ¥ TAYS i TgaH
B &, AR w@a: afeRa €1 s | fefate
dIfcTent 38 TEfad Sl & ot o el & 3R

fafem = wefifa e §:
247E4QSD:
ol USieA okl qiuTT
VESAHIE | difean H-sync V-sync ekl Tlg Sl LED ehei
. . . 29.3 T T
LED e | 1 Kl Gl (EL) EJEC
. . . EJE
kgl e | &l &t 05W (M) (o)
fa= s | o - - 03W (| AR
247E4QHKAD:
ol Weler Rl qiTsT
VESA HTS | dfife=n H-sync V-sync = hi 11';‘ Exl LED hei¥
. . . 303 W (HMHT)
LED &eR | 314 g B oW (o) EJEC
- EECS
S| e | &l EE 05W (=) (Fecter)
fa= ot | &1 - - 03W (TMHT=) Ah

247E4QHAD:
Froll S Rl qiHTST
VESAHIE | aifedl | Hsync | Visyne | S &t € Seit | LED e
. . . 303 W (EE)
LED e | & 7 B ow () || e
. . e
kgl e | Rl &t 05W (HME) (Fotr)
fa= ot | 81w - - 03W (THT=) ATH

247E4QHSD :
VESAHIE | Sifedl | Hsync | Vsync | HA I T Sl | LED e
LED TR | &1 & & 303 W (| 9
i S | TR T | 05w (FMEFI) (%?F)
o= oAt | % = = 03 W (HH=) A

23

247E4LSB:

VESAHIE | Sifedl | Hesync | Visync | ST &t TE SsTl | LED el
LED FeR | 319 7 | 204w (WMD) EJER)
. EJES
g A | & | Tl | 05w (ImMH) (Fet)
= A% | 3% - - 03 W (M=) o

247E4LHAB :
EXINVEERC IR IL)

VESATTE | Sifedll | Hsync | Vesync | R HT T Set | LED TR
LEDHeR | &1 7l 7l 2;173/3\(/ WYW)) EECS
o . e
i 1o B 3 B B 05W (EH=) (i)
fa= e | & - - 03W (FHT) AR

247E4LHSB :
ol Weier ehl TiRwTST
VESATE | Sifedll | Hsync | Vesyne | ST B T et | LED e
LED FeR’ | &9 7l g 213 W (FTHT=T) EJERS
. A E
i e | Rl &t 0.5W (|MI) (Fem)
o= oA | &w - - 03W (HM=) HH

T A1 | 9o’ & &9 ol HI9H i & fag
Trgferiad Yestq s ST foman SaT § |

« T fSIegM: 1920%1080
s HI: 50%

«  MESAY: 250 nits
»  HoR AIHM: 6500k HYUT Tee Yo o w1y

S e

I T2 for o & uRafida foran s wehar € |




7. TamHes SR

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!
This product is TCO Certified-for Sustainable T

TCO Certified is an international third party

sustainability certification for IT
@ products. TCO Certified ensures that

the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited
independent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

Corporate Social Responsibility

Socially responsible production - working
conditions and labor law in manufacturing
country

Energy Efficiency
Energy efficiency of product and power supply.
Energy Star compliant, where applicable

Environmental Management System
Manufacturer must be certified according to
either ISO 14001 or EMAS

Minimization of Hazardous Substances
Limits on cadmium, mercury, lead & hexavalent
chromium including requirements for mercury-
free products, halogenated substances and
hazardous flame retardants

BerlsEs 6T HpHTElss]

24

Coding of plastics for easy recycling. Limit on
the number of different plastics used.

TS Borees RTHats Age T80

Minimum one-year product warranty. Minimum
three-year availability of spare parts. Product
takeback

FERISREER

Limits on hazardous substances in product
packaging. Packaging prepared for recycling

AeHZISST, RGE REeeesd HRRIsEs

Visual ergonomics in products with a display.
Adjustability for user comfort (displays,
headsets) Acoustic performance — protection
against sound spikes (headsets) and fan noise
(projectors, computers) Ergonomically designed
keyboard (notebooks)

HECTRESTgY TE6LRA, 563663 FHT R TG ERSARE"
R I e Retctcec ozt JBe [ St

All certified product models have been tested
in an independent, accredited laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable IT for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around

the world rely on TCO Certified as a tool to
help them reach their sustainable T goals.We
are owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For more information, please visit
ww.tcodevelopment.com

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)

EPEAT



(wWww.epeat.net)
)  The EPEAT (Electronic
Product Environmental
TN Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through

an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

«  EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

*  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

«  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

«  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

* EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

*  2006/95/EC (Low Voltage Directive).
« 2004/108/EC (EMC Directive).

«  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption)

And is produced by a manufacturing

organization on ISO9000 level.

*  1509241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

* GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

* TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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(1) Changes or modifications not
expressly approved by the party responsible
for compliance could void the user's
authority to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
l'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

(1) Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spsacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The ussr of the
device is obliged to taks all staps necessary to remove sources of intarfarence o tels-
communication or athar devices.

Pokud nani na typowam Stithu
spadd automaticky do tfidy B podie EN 55022, Pro zafizeni zatazrend do thidy A (chranné
péamo 30m) pedie EN 55022 platl nésledujicd. Dojde-ll k rufenl telekormumikatnich nabo
Fnich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rulieni odstranil.

uvedano, #a spadi do do ffidy A podie EN 55022,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Usradzeide powiano byd zasibane = galazds 2 preybacsnym obwodem ochronmym (gniasdo 2
kolkvenh, Wapdtpracugnce ze soby uresdeenia (komputer, monator, drokarkap powinny by msilome
# i sk rddla.

Instalacja elektrycoma pomieszceenta powine mwiesas w preewadsie Browym reeeraows achrong
proec] swarciami, w postaci bezprecenika o warkedcl mamionowe] me wigkszej nit 16A {amperew ).
W eelu catkowitego wylacrenia urzadeenta 2 siect zasilania, naledy wyjat wivezks kabla
sasllaigeego 2 gmazdka, kidre powlmnno ssjdowad s w pobliag ureadeenda 1 byd 2atwo dostgpie.

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* Mie maledy whwad wiyceek adaptenowvch lub wuwad kedka abwodi ochronnego = wiyceki.
Tedelt komsecene jest whycie preedbutacza e naledy whyd preediuiace 3-avlowego 2
prawidbowa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-
kami napsgcia, wiywijae eliminatan preepies, urrasdzemia dopasawajacege leh
berraklaceniowegn Frodia easilania

Maleiy |||1vm|t sl albvy e o lekaloona kablsch systerni kull'qmll:uml.gfr arax aby kable me
byly umieszczone w |n||.| cu, gideie medna byloby na nie nadepiywad lub porylst sig o me.

* Mie maledy rozlewad napogia am meych plyaio s systeim kampubenowy.

Mie maleiy wpychal fadnveh preedmictio: do abwendw systenu kemputercwega, plyi moke
ta spowodowai pegar lub porasenie prydem, poprees swancie elemeniaw wewngirznych

- Syt kompulenowy powiiac enapdowad sl 2 dala od greejnikbo o deddel clepla. Porsdro,
re paledy blakawas atwerdw wentylacyjeych. Naledy unikac kladeensa luznpeh papseriw posd

kampriter sz amisseczania kampabera wociasnym migjsew bex mazliwass cyrkalacii powi-
elnm wokol nisgoe.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schidden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
Il & 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdagt 7/0dB (A) oder

weniger.

7 ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

S EABERHS
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BRETRATE] X [@ @) O @ €]
AR AT X O [e] [e) € [e)
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BREEESE | x e @ [s} € [e}
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O FFAAEE RN S A R o g B
CR TR s B SR AR R A AR RS T
X | R EA B R E A A A R
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EU Energy Label

|

PHILIPS  wovuonm

The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 year

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



8. UEeh WaT 3T aret

8.1 Philips ST Wie Uet Ait-eT fUadet
2y Hifa
Philips S=aa® T[UIE aTet eI < o Tl TomeRa
TEdl © | 89 SR & 9 T S=1d ScareH
gfshanat 1 SRIHTeT hid § SR WE Ture s
AN X & | gTeAifen, -l wie T9e Affedt
T T 8 a1t TFT \ife e T fieda =
39 foeriet o SIS | e Gore T2 g § 1 RIS off
frafar et et & Srfed g ot RS 7ET § TR,
wferd ferdt AT § 9fe <9 Wil &R 9 31feen
gl df Al & STAA Philips SHh! TG L A1 39
IS I TR <A1 § | T8 FE-97 fafa= gehr
% faeda St & 9R H Farr § 3R e YR § 2
% T wRI ol uRefd &Y § | 9REl % d'd
TG A1 ITEATI i IRl YT i o T st
AT 7 R foerda <l 6t e 31 Wi @i
¥ Afes g =T8T | Seredul & fag, fowd Aifae |
0.0004% ¥ Aok Tl fueda Srqul T&1 81 Hehd |
Tk 37T, Philips SHU bl o1 H @9 TR &
fyelier it 1 <t & Gare o ferg, S i
TehTeel 2Afersh e STehfd i €, 3R eifush 3=
e ATt e T Sl ¢ | 98 =ifd gfan o) #
AT

(u= fueder )

)
et
o

foeet oI wa Tyt

T Tueiet, =1 TR ac o, 2 3R el Tt o
A wrafiyer Wi % Gefusde 9 o4 g1 § |
ot T W1 et T fa o9 € | 519 TRt
Tt & 9t oo fYsfiet Jehifyrd €1 €, <t =i e
T fUaae T 91y ettt gthe fUede & &9

T gehe Bid & | STl Gt STYeRIIG Ted €, a1 dHi Tie
Td fIe T 91y fade T el fuedd & &9 1

%

30

fe@rE 2d T | g1 SR STeRIfTd ge fueiet & &=
TS 377 i o Tohdl fUaddl o &9 H Jahe Tid
g

fuee i o U

foeret &R ga fuiet g fafi= wisi @ A ™
fearE < € | Tyt <l &t <1 S gkl € 9
it § ek YRR o Tl el S0 Bid § |

T3S (AT ) B W

1SS S ST SHIM YR AT 37 @ el fuade
o1 ga fyeda & w9 8 fewrE Tar § | 3 fon, sge
Tfe Ueh UET 9o f9iet giam § S AifHeX o erh Ued
TR S W 3T 9 f@rE <1 7 | 9Ee €fe 39 R

freferfed gr B1d &

4 N

g J
Tk YR e, & A1 <iieql | foaiat
4 N

| ¢
N J
S FHTOE YeR1ea Tl e
- A + e = S
- o + g = e
- B + e = gRaa (geh ie)
Ve N

- /

T HIIE Yo T Teia (T Tihe fuede)




6 e

oI AT AT ST8e Sie SATHA o Sied 9 50 Ffaer
Ak THeRTen 1 TfET Salfeh T e Sfe
STEITE % Sfecd | 30 Ufawra 214k =ehiet g1
Sl

=Tk Tl IW

Tuerer aret ot Meredar

<{feh Teh—gE o hilel TEerd Teh Bl Tohr o foerie
AR T fyeriel S 3tfeeh &I e o Thd §,
Philips Taeraet 2t ot fehear o fag weiadr S
off frerifid swean 2

4 N
T <l S wien < e i f 4 R
o1 g fooael & w9 H fem@rE <ar & | 9 o,
T B2 Ueh U1 ol foerel grar @ i |if et &
THhIA Y2 feam W Bhia W 31er 9 fe@ < .
? | s ere 3 & frfafEd YR 8 &:
[ - ~ . - . ’
I Torereet S wEraar
IR} Tty % SRE HOHA a1 Fq€d= st g
I & &k AT Philips & et Tete T9a wiftex
& TFT TifeX U9 o f=fafaa afeesst §
N ) Heiterg weeerd & stferh et =1 39 e
- 7 Y T AT |
EEAINGRECIREE Gl 3
2 GHTIEe YehITIa Hetaedal 1
3 GHiuEy FeRIfId Hafyedd (T Rree fusde) 0
T SI13E €le qui < o= shi g * >15 foet
Tt TR & FdA oSS Sie M 3
1 STYRIIIIG HeIade 5 O FH
2 THIEY YRR Taqad 2 A HA
3 THIYEY STYRITT Fafaeaet 0
Tl &k Sie Nl o o @ gu >15 et
Tl PR & =ieh S 5 1 HA
Hel gl A TreRTd w1
[off YR o FA IS AT eIk S N 5 I HH
6 e

1. 1312 AHIME & 9o fqeled § < = 1 €2 |

R, FE WX 1509241-307 o TTEA § (1509241-307: Seiai-eh fagjstal fedw o fore sw=m aRfeufa foam
Hal eTravaehard, foeei™or 9 sTgure gq Si™ gonferai)



8.2 WTgeh ¥aT 3R arel

3ok &5 o TTT A AT hollSl Gl 9 ATdRH Teral ATaeFehdll S & 35vd 9, FHual faawo & fag
www.philips.com/support JeETge T ST | mﬁ%ﬁ%ﬁa@mm Philips o 379 T HEHT HeR H h
T TR W ol T F Tehd § |

ftrentt v 8 o for wuds weiel STERT:
2t AsC R S A e
Germany Siemens 1&S +49 01803 386 853 €0.09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 € 0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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T AR Qo I & o fog dueh Geied STt

ER

hicl HeT

ASC

THRI R o

Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
;eg?i;f‘egm NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
U NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
e NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

A AR & & foau Tueh daelt SR

Brazil 0800-7254101
: Vermont
Argentina 0800 3330 856
=i o 1T Hueh Geelt Seern:
=
FHI HA Fe: 4008 800 008
SR STHERT o feTT Hueh Helel SHehi:
Country Call center ASC Consumer care number
USA. EPI - e-center | Qwantech (877) 835-1838
Canada Supercom Supercom (800)479-6696
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THTHET &5 & foTu Gueh Geieht STHehm:

Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PLILIPS to 56677
: : : : : Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
cnited Arab | AL SHAHD COMPUTER LL.C | 00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Cormpany Ltd +84 5113.562666 Danang City
pany Ltc. +84 5113.562666 Can tho Province
e : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d.IStI"IbUtOF‘ and/or service
provider currently
Banoladesh NA Distributor: Computer Source | 880-2-9141747,9127592
E Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4227395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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